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Overview

This document provides a detailed and technical description of the Integrated Development Environment,
(IDE) for Control-C. This is a personal computer based program for use with the E-Node range of network
enabled programmable industrial control modules.

Control-C is used to create and develop user programs and perform all other programming and set-up tasks
required on the E-Node range.

A free copy of Control-C together with installation instructions can be downloaded from www.etrol.co.uk .

Control-C and System software version control

Control-C and the E-Node system software are regularly updated with improvements and corrections. Each
update has a unique version number in the form XpXX added to the file name, e.g.

ControlC2p02.EXE The main Control-C program (windows executable file)
Enode2p02.BIN The E-Node system software (binary file)

b For correct operation the Control-C executable file and the E-Node system software file must both have
the same version number and they must both reside in the same directory.

Approach

At Etrol Ltd we like to 'Keep It Simple' or 'KIS'. You will find this theme runs through everything we do and is
reflected here in this document. If you start Control-C and then read this description you will see that is
simply starts at the left hand side of the screen and works to the right hand side detailing all the functions as
it goes.

Feedback

If you find any errors, omissions, or have any suggestions to improve this document please email us at
feedback@etrol.co.uk.
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The Main Screen

If you start Control-C the following main screen will appear.

[7-'1: Control-C 2p04 M=%}

File Edit Mode Program  Ophions  window  Help

FHOE ARSI = ZBrrEEEn KR 0 K E|E

Status Information Window.

The Control-C IDE Main screen.

The Main screen is split vertically into Three sections.

The Menu/Control bar (top)

This area holds the familiar windows drop down menu system with the short-cut button control bar just
below. The description of the functions found in this area is the main task of this document.

The Editing/Program Area (middie)

This is where the general purpose windows for user program editing and development are held.

The Status Information Window (bottom)

This window shows the latest information that has either been requested by you the programmer or that
has resulted from some action you have taken. Messages in this window generally take the following
form:-

000 - No Node Errors

000 - The Node Type is SCREEN
000 - The Node is UNLOCKED
000 - The Program is RUNNING

The first Three digits are the node address associated with the action requested that resulted in the
message.

© Etrol Ltd 2009 5 www.etrol.co.uk



Also communication time outs generate a '-' character in this window. This can occur when waiting for the
E-Node to reset/update or when a communications error has occurred.

This window can be resized by the normal click, hold and drag operation on the top border.

www.etrol.co.uk 6 © Etrol Ltd 2009



The Menus

The Menu and Button bar's use a scheme of 'greying out' an icon if that facility is not available or not allowed
at the time the menu or button is displayed. If you find an item is greyed out when you think it should not be,
it is most likely that an operation is currently taking place that locks out that feature for safety or that an

option has not been enabled or that a file is not open.

The File Menu

= Qpen/Mew Chrl+ 0
= Open/New (Ctrl+O) & save Chrl+S

Opens a window from which you can select and open an existing ﬁ Save Al Shift+Ckr+5
file or type in a new name to create a new file. @ )
If the file opened is of the type .CCC Syntax colouring will be Save As...  Shift+Chr+-A
applied. Close
There are Three predefined file type filters:- Close Al
Control-C User Program Files (.CCC)
Control-C List Files (.CCL) Prink Setup...
Control-C User Binary Image File (.CCl)

& Print Chri+p
.CCl and .CCL files are created when a user program is
compiled successfully with the options selected. Exit
b All .CCC files have a companion initialisation file with a .IN/ The File Menu

extension. This file is created automatically by Control-C and
should not be modified. Whenever a user program file (.CCC) is moved or distributed its Companion
file (.INI) with the same name should accompany it.

Save (Ctri+S)

Simply saves the file in the open window.

b If the file in the open window has been saved the icon will be greyed out until the file is modified.
Save All (Shift+Ctrl+S)

Saves all the open files regardless of their status.

[d Save As...(Shift+Ctrl+A)

Opens a window to allow saving the open file with a new name.

Close

Close the open file. If the file has been modified you will be prompted to ask if you wish to save it first.
Close All

Closes All open files. If the files have been modified you will be prompted to ask if you wish to save
them first.

Print Setup...

Opens the print set-up dialogue window.
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&p Print (Ctrl+P)
Prints the entire content of the open window to the printer.
Exit

Exits Control-C
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The File Window

!

‘Ec Moname.CCC

Address |0 «||0 « |0 «| Breakson ¥ ListFileon | ImageFile on | |
main ()

{

4Y Program starts here!
H
Lm 0,Caol 0O | Saved | Compiled | 1% memary used. | Insert A

An open file window
The File window as show above consists of the following fields.

Address field (top)

This is a very important field. These 3 digits select the network address of the node with the following
effects:-

1. Unless otherwise specified in the user program this is the default address used when the user
program is compiled.

2. This is the address the program will be downloaded to.

3. ltis the initial address seeded into the address field for other communications operations chosen
when the window is active. e.qg. if the address selected is 010 and a 'Read Node Status' request is
made the address 010 will appear in the new window address field.

Breaks On (top)

Check this option to compile user programs with break points. This will enable the program to be
tested by the means of 'Run to Cursor (F8)', 'Single Step (F9)' and 'Run to Cursor (F10)". With breaks
on the user program runs approximately 5% slower and consumes approximately 10% more memory.

ListFile On (top)

Check this option to force the compiler to create a List file (.CCL) when the user program is
successfully compiled. List files can be opened for viewing in a File Window by using the 'Open/New'
dialogue with a .CCL file type filter.

A List file shows the break down of the user program into the machine code and memory location used
by the Coldfire microprocessor within the E-Node. It is provided as an advanced method of program
development and debugging. The List file is not used or stored on the E-Node.

© Etrol Ltd 2009 9 www.etrol.co.uk



ImageFile On (top)

Check this option to force the compiler to create a Binary Image file (.CCI) when the user program is
successfully compiled. Binary Image files contain an exact copy of the E-Node memory complete with
the compiled user program.

These files are used to update user programs in the field without disclosing the original user program
code. The user program is first written and tested at base and then a Binary image file is generated
and sent together with the companion .INI file out to site. On site it is downloaded onto the E-Node
using the 'Download User Binary Image (.CCI) To Node' option in the 'Node' menu.

The Text Window (middle)

This area contains any text belonging to the opened file. This window is primarily used for creating and
editing text and supports all the basic Windows editing commands. In addition if the open file is a user
program (.CCC) the following features are enabled:-

1. The syntax is coloured when the file is opened and dynamically as new text is typed in. This helps to
prevent errors because all key words are coloured and incorrectly typed entries are easy to spot.

2. When the program is compiled any errors are highlighted and the text cursor is placed at the point
the compiler found the error. The compiler also displays the error in the status window and suggests
what it was expecting to find.

3. When using break points the line the program is currently stopped on is highlighted. Therefore as the
program is stepped through the highlight bar moves through the program indicating the current point
of execution.

File Status Bar (bottom)
This field contains current information on the status of the file in the text window.

Field 1. Line and Column position of the cursor.

Field 2. The Saved or Modified status of the file.

Field 3. The Compiled or Not Compiled status of the file (.CCC files only).

Field 4. The percentage of E-Node memory used after successful compilation (.CCC files only).
Field 5 Text entry mode, Insert or Overwrite.
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The Edit Menu

¥ Cut (Ctrl+X)
Cuts any selected text to the Windows clipboard.

Copy (Ctri+C)

Copies any selected text to the Windows clipboard.

Paste (Ctrl+V)

Pastes by inserting any item on the windows clipboard to

the current position of the text cursor or if any text
selected it will overwrite the selected text.

Select All (Ctrl+A)

Selects All the text in the current window.

Find / Repeat - Replace (Ctrl+F)

¥ oo Chrl+3
B Copy Chrl+C
Paste Chrl+y
Select all Ckrl+-4
#h Find | Repeat - Replace  Ctrl+F
is Find again F3
The Edit Menu
Find / Repeat - Replace

Opens the Find /Repeat - Replace window.

Use this window to find and replace text in the
currently open window.

Enter the text to find into the 'Find Text' field or
highlight the text to find before open this
window and the highlighted text will

Find Text:

Replace Text: I

Find / Repeat I
Replace I
Mesct Window |

[~ Match Case

Find / Repeat: Searches from the cursor down through
the program then continues again from the beginning.
Replace: Replaces highlighted text with the Replace Text'

Click Next Window' to Search/Replace the next open window.,  Zancel (Esc)

automatically be entered into the 'Find Text'
field. Press 'Find / Repeat' to find and highlight

that text in the open file window. Press again to find again.

Enter the text to replace the found text into the 'Re
highlighted text. If this field is left empty found text

place Text' field. Press 'Replace' to replace any
will be erased if the 'Replace’ button is pressed.

The 'Next Window; button switches to the next text window if more than one window is open.

Check the 'Match Case' box to only find text that exactly matches the case of the 'Find Text' text.

Press 'Cancel' (or the Esc key) to quit this window.

Find Again (F3)

The last text entered into the 'Find Text' field of the 'Find / Replace - Repeat' window can be searched
for again without having that window open by pressing F3 on the keyboard.

© Etrol Ltd 2009 1
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The Node Menu

. . . . Zonfi Mod Chrl-alk+C
This menu contains all functions relating to the 1§ Configure tod '

communications with and setup of nodes. ’E Save User Program File To Mode File Store Crrl4-ale4+T

"g Read User Program File From Mode File Store Ckel+AlE+HF

’g Dawnload User Binary Image {0 To Mode Chrl+alk+1
l:a Backup Binary Image to Mode Image Store Chrl+alk+E
I:a Restore Binary Image from Mode Image Store Chrl+alk+R

Screen Bitmap rmanager CErlHAlE+HM
|2| Lock/UnLock Mode programming CheH-AlE+HL
B Download System to Mode Chrl+Alk+5

Factory Configuration (Factory only) Chrl+AlE+HR

[:a:] Configure Node (Ctrl+Alt+C) The Node Menu

Opens the window for configuring E-Nodes.

Configure Node
Fragramming Infarmation Metwark Configuration Information
Read or Program node configuration. IMPORTANT: When configuring a node the E-Node
‘Read' uploads the connected node configuration. Programming Adaptor cable MUST be plugged directly into

the E-Port connector on the node you wish to configure. All
Nodes must be configured individually when the system is
set up and before any user programming is performed.

o j' u j' o j' Sl Ful (ol Aakiliess (A i) The Full Mode Address range is from 000 to 992

0 =0 «||0 =| Select Group Address High (Gateway nodes only) Modes are usually grouped together. A Single group share a
comman CAN (Cantral Area Metwark). Communications within

Program’ downloads the selected node configuration.

mlﬂ—;”G Select Group Address Low (Gateway nodes anly). the group use the CAM. To communicate with another group each
group must have a ‘gateway' node connected using Ethernet
2000 ~ Select CAN Speed (Khbitss). hardware companents.
All Nodes within a single group MUST have the same CAN
[ Allow gateway to pass broadcast varables (Gateway nodes only). Speed

‘gateway' nodes (those with an Ethernet interface) rmust be
programmed with the higher and lower address bounds for its
[~ Run Program on Mode Power Up [ P.O.R. J(AIl Modes). associated group. This allows message filtering to take place.
IF BOTH ADDRESE BOUNDS ARE 000 THE GATEWAY
FACILITY 1S DISABLED.

[~ Lockout startup calibration on Screen Modes (Screen nodes only).

Brograrm : Bead Cancel (Esc)

This is a very important window. Before any node can be programmed or used it must first be
configured using this window.

Please read the information in the window carefully.

This window configures all types of E-Nodes. The set-up information required depends on the type
of the node being configured

The E-Node Programming Adaptor cable must be plugged directly into the E-Port connector of the
node to be configured.

Select Full Node Address (All Nodes)

Use this field to select the permanent network address for the node. Every node on a single
network must have a unique address in the range 000 to 999.

When the whole system is configured ANY E-Port may be used for normal programming and
testing operations.




Select Group Address High (Gateway nodes only)

E-Node networks are made up of groups. All nodes within a group share a common CAN (Control
Area Network). To communicate with another group the group must have a 'gateway' node
equipped with an Ethernet port. When a gateway node receives a message from its local group
CAN network it needs to know if it should pass it on over the Ethernet section of the E-Net network
to other groups. To determine this it must have knowledge of the highest and lowest address for its
local group. Any message with a destination address outside this range is passed on over the
Ethernet section of the E-Net network.

Use this field to select the highest address for a gateway's local group.

Select Group Address Low (Gateway nodes only)
Use this field to select the lowest address for a gateways local group.

b If the high and low group addresses are set to '000' the gateway facility is disabled.

Select CAN Speed (Kbits/s)

Groups sharing a single CAN network must all have the same CAN speed setting. The maximum
speed in accordance with the standard CAN specification is 1000 Kbits/s, however the design of
the E-Node allows a maximum of 2000 Kbits/s. The speed chosen is determined by the physical
length of the CAN network. To achieve reliable communications Etrol Ltd make the following

recommendations:-
Can Speed (Kbits/s) Physical network length.
2000 0 to 10 metres
1000 10 to 20 metres
500 20 to 40 metres
250 40 to 80 metres
125 80 to 160 metres

Allow gateway to pass broadcast variables (Gateway node only)

E-Nodes can be programmed to broadcast variable values on a repeated time basis. These values
are always received by all nodes in the local group. To share these values with other groups this
field must be checked. With careful use of gateway nodes the whole network can be partitioned to
allow the use of different broadcast variables in separate sections of the network.

» A maximum of Two Broadcast variables can be used for any one receiving group or groups of
nodes. If more than Two are set up overwriting can occur with unforeseen consequences.

Lockout startup calibration of Screen Nodes (Screen nodes Only)

Screen nodes can be placed in calibration mode when first powered up by the pressing of the
touch panel. If the subsequent calibration is not performed correctly this could disrupt normal
operation of the Screen. Check this option to prevent prevent the Screen node entering this mode.

Run Program on Node Power Up (P.O.R) (All odes)

If a node has been programmed with a user program it can be set to automatically run when power
is applied. Check this option to enable Power On Run.

Click the "Program’ button to program the node with the values shown in the Configure Node
window.

Click the 'Read' button to read the current configuration from the node and overwrite the fields of
the Configure Node window.
Click the 'Cancel’ button or press the Esc key to exit the Configure Node window.
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Save User Program File To Node Store (Ctri+Alt+t)

Opens the 'Save File to Node Store' window. Save File to Node Store

Each node can store One full user program. — Infarmatian

Save the User Program in the currently open
window to the Node Staore of the addressed
node.

Any node can be used but the main purpose of the
store is to hold a copy of the program that it is
currently running. This provides a safe backup in the
event that the original is lost or modified. Flease Mote. The current content of the
Mode Stare will be overwritten.

The 'Node Address' shown is where the copy will be

. . . _—
stored. All control is lost during this operation!

b The original content of the Node Store will be |u jl 0 jl 0 j Made Address
overwritten. )

| Save to Store | Cancel (Esc)

Click 'Save to Store' to complete the operation.

Click 'Cancel' or press the Esc key to abort.

Read User Program File From Node Store (Ctri+Alt+F)

Opens the 'Read File From Node Store' window. Read File from Node Store

To perform a read a file window must first be = (it
opened.

Read a lser Program file fram the Mode
Store addressed below into the currently

Click 'Read' to read a copy of the user program from A -

the node with the given 'Node Address'. The

contents of the file window will be overwritten. No Please Mate. The content of the currently
other changes are made. open editor window will be overeritten.
Click 'Cancel' or press the Esc key to abort. All control is lost during this operation!

|0 =|j0 =|f0 | Node Address

: Read Cancel (Esc) |

Download User Binary Image (.CCIl) To Node (Ctri+Alt+l)

Use this option to program the node without having a copy of the original user program. The original
user program must have been successfully compiled with the 'ImageFile On' option checked to enable
it to create a file with the '.CCI' extension with the same name as the original.

b The ".CCl' file together with its companion file ".INI' must be available in the same directory location.

The 'Download User Binary Image (.CCl) to Node' option will be 'greyed out' until the following is
performed.

From the 'File' menu select the 'Open/New' option. Search for the chosen file name using the .CClI

filter. Opening the file brings up the following special file window.

Please read the instructions in the window. In particular it is important that the original user program
was compiled using the same Control-C and Bootloader versions as those on the target node.
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e MewProgram.CCl

BEX

for a successful Download to be possible.

Saved

Ln 16, Col 0O

To execute a download elick "Node' then "Download Binary Image

This file must be open to allow Binary Image Download.

This File was compiled for a Node with address 000.
However you may optionally change the destination address in the Download window.

This EBinary Image was compiled with Contreol © wversion Z.02.
The wersion of Contraol C you are currently using and the version of the
System software on the target node must all match the Binary Image wersion

Also this Binary Image was compilled for Bootloader Version 1.
The Bootloader wersion of the target node you wish to program must match
the Bootloader wersion the Image was cowmpiled with for a successful Download.

{(.COCI) To Node'.

Insert

With this window open the 'Download User Binary
Image (.CCl) to Node' option becomes active. Click
it to open the 'Download Binary Image to Node'
window.

In most circumstances the 'Node Address' should
match that with which the original user program
was compiled. However there may be cases for
which this is not required. For example where the
same program is installed on many nodes.

Before proceeding it is recommended that the
current User Binary Image within the node be
backed up on the node using the facility provided. If
the new image is found to be faulty the old image
can then be restored.

Click 'Download' to complete the operation.

Click 'Cancel' or press the Esc key to abort.

Download Binary Image to Node

Infarmation

Download the chosen and pre-compiled
User Binary Image to the Node addressed
below.

Flease Mote. The current Lser Binary
Irmage in the node will be overawritten.

You can Backup and Restore the current
Lser Binary Image using the features
pravided in the Mode drop down menu.

All control is lost during this operation!

0 ~||0 -)l0 =] MNode Address

Cancel (Esc)

Download

Backup Binary Image to Node Image Store (Ctri+Alt+B)

Use this option to backup the current binary image
(the machine code version of the user program)
from the node's main memory to the Node Image
Store. It is recommended this be done before
downloading a new Binary Image.

Clicking this option opens the 'Backup Binary
Image to Node Store' window.

The Node Store can only hold a single copy of the
Binary Image. The current image in the Node
Store will be overwritten with this operation.

The given 'Node Address' is where the backup
operation will take place.

Click 'Backup to Store' to complete the operation.

Click 'Cancel' or press the Esc key to abort.

-

Backup Binary Image to Mode Store

-,

Infarmation

Backup the current User Binary Image in the
addressed Mode to the store within that
Mode.

Flease Mote. The current content of the
User Binary Image Backup Stare in the
Mode will be overwritten.

All control is lost during this operation!

|EI j‘[l j‘Dj Mode Address

Cancel [Esc)

| Backup to Store |




Use this option to restore a previously backed up
binary image (machine code version of the user
program) from the node's image store to the main
memory.

Clicking this option to open the 'Restore Binary
Image from Node Store' window.

This operation will overwrite the current Binary
Image stored in the node's main memory.

The given 'Node Address' is where the restore
operation will take place.

Click 'Restore' to complete the operation.

Click 'Cancel' or press the Esc key to abort.

| Screen Bitmap Manager (Ctrl+Alt+M)

EE Restore Binary Image from Node Image Store (Ctrl+Alt+R)

-~

Restore Binary Image from Mode Store

-,

— Information

Restore the current User Binary Image on
the addressed Mode from within the store
on that Mode.

Please Mote. The current User Binary
Image in the Mode will be overwritten.

All control is lost during this operation!

|0 ~|f0 ~|f0 | Node Address

Cancel (Esc)

estare

Use this option to manage the storage of Bitmap graphics image files on 'Screen' type nodes.

The Bitmap images must be provided in the
correct format before they will be accepted for
storage on a Screen node. This format is
described in detail in a separate document to be
found on the Etrol website.

Clicking this option opens the 'Bitmap manager’'
window.

The Bitmap manager function centres around the
list of file names shown in the middle area. This list
is held on the computer and manipulated by adding
bitmap files from the computer. Deleting all the
bitmaps and reading the bitmaps stored on the
addressed node.

Click 'Add Bitmap' to add a ".bmp' bitmap file to the
end of the list,

Click 'Delete all Bitmaps' to clear the list.

Click 'Read Bitmaps' to copy the bitmaps stored on
the node at the 'Node Address' into the list. This
action overwrites the original list contents.

Click 'Save to Bitmap Store' to save the contents of
the list to the bitmap store on the node at the 'Node
Address'. This action erases the original contents
of the node bitmap store. If the list is empty this will
clear the bitmap store.

Click 'Cancel' or press the Esc key to abort.

Lock/Unlock Node Programming
(Ctrl+Alt+L)

Bitmap manager

£

— Infarmation

Organise Bitmap files on the addressed node
[SCREEN MODES OMLY).

‘Read Bitmaps' will read the bitmap file information from the
Mode into the displayed list.

Delete All Bitrmaps' deletes all bitmaps from the displayed
list.

‘Add Bitmap' will add a selected Bitmap file to the end of
the list.

‘Save to Bitmap Store’ saves the displayed list to the Mode
Bitrap Store, overwriting the current contents.

All control is lost during this operation!

Murmnber I Filehame

00~ O M e LD 3 =

[r=]

10
11
12
13
14
15

Awailable empty storage space - 100% (1175551 bptes)

[0 ][0 ][0 ~] Mode Address

Dielete all Bitmaps |

Read Bitmaps

MmE

Save to Bitmap Stare | LCancel [Ezc)




Use this option to Lock or Unlock the node for all
programming operations.

Lock/Unlock a Mode

Clicking this option opens the 'Lock/Unlock a Node'
window.

To Lock the node at the 'Node Address' enter a
number in the range 1 to 65535 and click 'Lock’.

> When a node is locked no programming of the
node is permitted.

To Unlock the node at the 'Node Address' enter
exactly the same number used to originally lock the
node and click 'UnLock'

— Information
Lock or UnLock the addressed Node.
Locking a node will block all programming operations
UnLocking a node will allow all programming operations
Use EXACTLY the same code to Lock and Unlock

All control is lost during this operation!

IEI v”EI vl 0 =| Mode Address

Please enter Lock code number?
(Range: 1 to B5533).

Lock | UnLock Cancel (Esc) |

Click 'Cancel' or press the Esc key to abort.

Download System to Node/s (Ctri+Alt+S)

Use this option to download system software to a
node/s.

The version of Control-C is always matched with a
copy of the E-Node system software with the same
version number. The system software must reside in
the same directory location as Control-C and its name
will take the following form:-

ENodeXpXX.BIN
Where XpXX is the version number, e.g. 2p02.

Updated system software will periodically be made
available on the Etrol Website.

The downloading process follows a set procedure
please refer to the paragraph 'Download (F6)' for more
details.

e

Download System Software to Mode/s

~.

Information
Version 2.06

Dawnload this version of System Software to
the addressed Models.

All control is lost during this eperation!

& Download to a single node
|0 >0 =|f0 +| Mode Address

i Download to all node in this address range

I jl jl jStanNndeAddress
I jl jl jEndNndeAddress

Cancel (Esc)

‘ Download to Modeds |

Select the required node address or address range and click 'Download to Node' to execute the

procedure.

Click 'Cancel' or press the Esc key to abort.

b The version of Control-C and the version of the system software on the node MUST be the same.

> When a compiled user program is downloaded to a node the system software version number on
the node is checked. If it is different to the version of Control-C being used a warning window will be

displayed.

b Generally system software download can be achieved using any E-Port connection on the network.
However if any difficulties are experienced plug directly into the addressed node. Do this for every

node in the system.

Factory Configuration (Factory only) (Ctrl+Alt+N)

This is a password protected option provide for factory use only to configure newly manufactured

nodes.

© Etrol Ltd 2009
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The Program Menu

— Compile User F5
Use this menu to compile, download and debug user programs. PE Diownload F&
Most of this menu will be greyed out until a '.CCC' file window is ¥ Run F7

opened. The commands are duplicated on the button bar and F% run To CUFsor Fa
actioned by keyboard function keys for rapid access.

“E| single Step Fa
The command are grouped into Two sections. E% Step Over Fii
The topmost orange coloured group operate on the addressed Il Pause F11
node only (the address in the address field at the top of the file H
window). When you switch between file windows the address of Reset Fi2
the node these commands act upon switches as well. % Read Mode Skakus Fz
The bottom grey coloured group are 'global' commands operating ’ run Al CHl+E7
on ALL nodes on the network simultaneously.

Il Pause Al ChrFLL

4 reset al Ctrl+F12

4

Compile User (F5)

Fast Stop All Maves  Shift+Ctrl-+F12

Use this option to compile the user program in the active file The Program Menu
window.

When the user program is compiled a new hidden file is created containing a copy of the user program
converted into machine code. This code is directly readable by the microprocessor within the E-Node.
If the user program compiles successfully the machine code can be downloaded to the addressed
node for testing and subsequent use.

The compiler is a 'Single Pass' type. This means that it starts the compilation process at the top of the
file window and performs a single pass down the file until it reaches the end or encounters an error.

The compiler compares the file contents with the Control-C syntax diagram as it makes the single
pass. The Control-C syntax diagram describes the correct program layout from the top to the bottom. If
the compiler finds a deviation from the syntax diagram its location is highlighted in the file window, the
cursor is placed where the error was found and an error is displayed in the status window together
with a suggestion regarding what the compiler was expecting.

> Compilation is a difficult process to perform. The user is free to type anything into the file window
and the compiler must interpret this as best it can. When an error is determined the cursor is placed
where the compiler thinks the error occurred however in some cases the compiler will have just gone
past the real error before stopping and the programmer must look back to locate the error.

> Addressing

> Many commands in the Control-C language provide the option to define the node address for which
the command is destined. If this option is omitted the compiler will default to the address in the
address field at the top of the file window.

hg Download (F6)

Use this option to download the compiled user program to the addressed node. The main memory of
an E-Node is not programmed directly in case there is a communications failure during the download
leading to part programmed situation. Instead the program is downloaded into a serial Flash memory
first. The E-Node is then restarted and it checks the serial flash for a complete new program. If one is
found the main memory of the E-Node is automatically erased and the new program copied over in a
fully self contained operation.

Downloading takes place in several distinct stages. At each stage the Eight segment display (ESD) on
the front of the standard E-Node shows a particular activity and status information is given in the
status window. The stages are:
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A global reset is issued. All control is lost at this point. ESD shows all segments 'on' for a short time.

2. The required sectors of the serial flash are erased. ESD shows a clockwise light pattern on the lower
Four segments. One segment is lit for each sector erased.

3. Serial flash pages are programmed. ESD shows anti-clockwise light pattern on the lower Four
segments. One segment is lit for each page programmed.

4. The addressed node is reset to start the auto update process. ESD shows all segments 'on' for a
short time.

5. Auto updating takes place. If the serial flash contains a new valid program it is automatically

transferred to the main memory. When transferring the ESD shows a clockwise light pattern on the

outermost ring of segments. One segment is lit for each page erased and if that same page is also

programmed the central segment is lit.

If, for some reason the programming operation failed the last reset will result in an error condition. This
will be displayed in the status window if communications are good and on the ESD of the node in
question. Depending on the error type one of the following sequence of letters will be displayed on the

ESD.
ESD Sequence Meaning
E-lI-b-L Error, In boot Loader
E-S-C-F Error, System (program) Checksum Failure
E-U-C-F Error, User (program) Checksum Failure
E-P-E Error, Programming Error
E-E-E Error, Erase Error
E-U-I-b Error, User (program) Is blank
E-S-I-b Error, System (program) Is blank
E-F-E Error, Fram (write) Error

'-" indicates a short blank period on the display.
In extreme cases of poor communication the node may end up with a blank screen and possibly no

communications at all. Cycle the power to the node to reset it. It will then display any error messages
and communication will resume.

b Run (F7)

Use this option to run a user program (already downloaded) on the addressed node. The ESD top
segment will be lit to indicate the program is running and the program status will be reported in the
status window.

Run To Cursor (F8)

w
1

Use this option to run the user program at full speed and stop it on the line of the program where the
text cursor is positioned. When a program is compiled with the 'Breaks on' option checked every line of
the program is allocated a break point at which the program execution may be halted.

To use this option the following conditions must be meet.

—_

The file window must be open containing the user program.

2. The user program must have been successfully compiled with the 'Breaks on' option checked and
downloaded to the addressed node.

3. The cursor must be placed on the line required.

© Etrol Ltd 2009 19 www.etrol.co.uk



A program starts at 'main()' and progresses in accordance with the program flow as defined by the
programmer. It is normal practice to run the program to a cursor location where it will halt and then re-
position the cursor and 'Run to Cursor' again. However if the cursor is positioned before the halted
position or in a location that is never reached the programmer may be left forever waiting for the break
point to be reached.

Whilst waiting for a break point to be reached the computer is in constant communications with the
addressed node and no other operations can be performed in the IDE. The only way to exit this
situation is to press the 'Esc' key. The break will be aborted and the program will continue running
normally.

b If an error occurs whilst waiting for a break point the program enters the error handler and the
status window reports the error together with a suggestion for where the error was caused in the user
program.

b All queued motion commands issued before the break are completed.

b 'Run To Cursor'is greyed out if the program is not compiled and downloaded with the 'Breaks On'
option checked.
GZ| Single Step (F9)

Use this option to step through the user program one line at a time. The same conditions apply as
detailed in the 'Run To Cursor' description.

When using Single Step the full execution path is followed including entering and stepping through
subroutines.

b All queued motion commands issued before the break are completed.
b 'Single Step'is greyed out if the program is not compiled and downloaded with the 'Breaks On’
option checked.

[.E| Step Over (F10)

Use this option to step through the user program in the same manner as 'Single Step' except that
subroutines are executed at full speed and the break occurs on the next line.

b All queued motion commands issued before the break are completed.
b 'Step Over'is greyed out if the program is not compiled and downloaded with the '‘Breaks On'

option checked.

Il Pause (F11)

Use this option to immediately pause the user program on the addressed node. To continue program
execution from the paused point use 'Run'.

b The user program does not need break points for this option.

> Any motion command running at the time the break occurs is completed.

|4 Reset (F12)

Use this option to immediately reset the program on the addressed node.
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% Read Node Status (F2)

-,

Use this option to read the status of a node. It 6
opens the 'Read Node Status' window. ittt E

Click 'Read' to read the status of the addressed I':' jl L jl d j Mode Address
node and report it in the status window. |

Eead Cancel (Esc) |

Click 'Cancel' or press the 'Esc' key to exit.

B Run All (Ctrl+F7)
Use this option to run all user programs across the network immediately. The same conditions detailed
in 'Run' apply.

I Pause All (Ctrl+F11)
Use this option to pause all user programs across the network immediately. The same conditions
detailed in 'Pause' apply.

|4 Reset All (Ctrl+F12)
Use this option to reset all user programs across the network immediately. The same conditions
detailed in 'Reset' apply.

Fast Stop All Moves (Shift+Ctrl+F12)

Use this option at any time to rapidly stop all current moves on a system. It also clears all move
queues, pauses all running programs and on AXIS nodes only it floats the outputs (if these outputs are
used to enable amplifiers this will disable them).

b Stopping the move is achieved by setting the DACO output to zero with immediate effect. This is
fast but abrupt method and is only used to delivery the fastest possible stop condition.

b This is NOT an emergency stop because it relies on the integrity of communication links.

© Etrol Ltd 2009 21 www.etrol.co.uk



Option Menu

Use this menu to set up general options in the Control-C

environment.

Communications Setup

Check 'None' for no communications port.

Check 'USB' to use the Universal Serial Bus port for

communications with the E-Nodes.

Click 'OK' to perform the set up operation.

Communications Setup

Editor Options

Prompk Oplions

The Options Menu

¥ 1

Communications Setup

Select a Connection

 Mane  LUSH

G |

- The USB port driver must first be installed before the 'USB' option will work. If it has not been
installed a warning window will be displayed. Please refer to www.etrol.co.uk for further information.

Editor Options
Opens the 'Editor Options' window.
Indent options:

Check 'Auto indent' to automatically indent
text to the same level as the line above
when the 'Enter key' is pressed.

Check 'Auto unindent' to automatically
remove Two spaces when the 'Backspace
key' is pressed.

Syntax Format Selection:

Use this selection to customise the look of
the main file editor window.

Click 'Factory Syntax Format' to restore the
setting in the selection area to the Factory
values.

Click 'Save Syntax Format' to temporarily
save a copy of the values in the selection
area.

Click 'Restore Syntax Format' to restore the
values saved back into the selection area.

Editor Options

]

— Indent Options

¥ Auto indent onfoff (Enter key)
[ Auto unindent onfoff (Backspace key)

— Syntax Format Selection

ICDurier j TypeFace. IW_L, Font Size.
Wormal Text Change Calaur [~ Bold
Reserved Words Change Calour v Bold
Variable Hanes Change Calour [~ Bold
"Strings" Change Colour [~ Bold
Constants Change Colour [ Bold
{} Braces Change Calour v Bold
{1 Braces Change Colour [ Bold
Symbols +-1=6& Change Calour [ Bold
<7 Comments Change Calaur [~ Bold

Factary Syntax Format I Restare Syntax Format

All Black Format | Save Syntax Format

Apply Syntax Farmat | Done (Esc)

Click 'All Black Format' to reset the selection area to an all black format.

Click 'Apply Syntax Format' to save the format for future use and apply the format to the currently open

file window.
Click 'Cancel' or press the 'Esc' key to exit.

b This option only applies to .CCC file types.

www.etrol.co.uk
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Prompt Options

Prompt Options

When downloading user programs and reseting I~ Show prampt before DownlLoad User Pragram.
nodes all control is lost on the network. It can be
useful to check these option to prompt the
programmer before these actions are undertaken to
be certain he/she is aware that control will be lost.

[ Show prompt before Reseting Mode/s

In most circumstances experienced programmers will leave these options unchecked.
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Window Menu

Cascade

Cascades all open file windows.

Tile Vertically

Tiles vertically all open file windows.

Tile Horizontally

Tiles horizontally all open file windows.

1/0 Window (Ctri+F2)

Opens the 1/0 window for viewing the digital
Input/Output status of E-Nodes. Updated every
500 milli seconds.

Up to 5 node addresses can be displayed by
setting the value in the '"Number of Nodes' drop
down box.

Each sub window shows the selectable address
of the node, the type of node and the current
status of the inputs and outputs. If the node has
no I/O they will be greyed out.

Outputs can be toggled by clicking on the icon of
the number you wish to toggle.

The I/O icon lights up when in its active state. The
active state for PNP 1/O is different to NPN.

NPN

Input is low (0v)

Input is floating

(weak pull up to 24v)
Output is driven low (0v)
Output floating

(weak pull up to 24v)

Input active
Input inactive

Output active
Output inactive

PNP

Input is high (24v)

Input is floating

(weak pull down to 0v)
Output is driven high (24v)
Output floating

(weak pull down to 0v)

Input active
Input inactive

Output active
Output inactive

Cascade

Tile Wertically

Tile Horizankally
1} Window Chrl4F2
Yariables window  Chrl4+F3
Mexk Window F4

il

= Apply Synkax Format
The Window Menu

= ]
Input,;/Output Window I

Mumber of Nodes (1 to 5) i -

Address [0 ~|[1 ~||1 =] Axis
o020

lhputs |5 5 © 5 2 4 3 2 1 0
D B O N

Outputs | o =5 = 5 2 4 3 2 1 0

Axis with only 4 1/0

= ]
Input/Output YWindow I

Mumber of Nodes (1 to 5) 1 =

Address |0 ~||0 ~|[2 ~| PNP-O
222D

Inputs '3 g 5 5 5 4 3 2 1 0
2222 PO

Outputs |9 5 2 5§ 5 4 3 2 1 0

PNP with output 0 active

b The I/O status reported is that seen from the inside of the isolation barrier. For these values to
properly reflect the status on the outside of the isolation barrier the isolated 24v supply and ground
must be applied as detailed by the respective node connection data sheet.
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Vairables Window (Ctrl+F3)

Opens the 'Variables Window' showing the variable
values and node type for the addressed node. Updated
every 500 milli seconds and if the 'Refresh Variables

B
Yariables Window

Address [0 ~|[0 ~||0 ~| AXIS

Refresh Wariables “iew

View' button is clicked. — |Value
Variable are either 'Read Only' or modifiable. software version 20
addreszs u]
To modify a variable value click on it. If the 'Read Only' serial numher 7-11-8-15
icon changes to 'Send Value' you may enter a new node_type LT3
value and then click 'Send Value'. group_addr hi 0
group_addr_1ao 0
User defined variables and named sub-routine return power on run FALSE
variables (ie the declared sub-routine name) are crror 0
displayed at the bottom of the list. The User Program - :
must be loaded into a file window and it must be in the line with error o
compiled state for these variables to be visible. If two or node_with_error 0
more file windows have programs with the same node status 268436676
address an warning will be shown because the activity IDLE

Variables Window will be unable to determine which wade ABS [v]

program file variables to display. Froad Ol I

> Some variables will not accept a decimal term. If one
is sent it is simply ignored.

b Changing values is not permanent. A reset will always cause the default value to be re-established.
If the programmer wishes to override the reset value it must be done by programming the node to do
so.

Next Window (F4)

This option switches focus to the next file window if more than One is open.

Apply Syntax Format

This option applies the current syntax colouring format to the text within the open file window.

b This option only applies to .CCC file types.
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Help Menu

Resources

Opens the 'Help Resources' window.

Shows sources for help.

About
Opens the 'About’ Control-C window.

Shows the version number and release date.

Resources
Abaut
The Help Menu

Help Resources

Please try the following?
Online:  www.etrol. co.uk
Email.  support G@etral.co.uk
FPhone: [+44) 01730 516393

rﬁ. bout

Control-C Programming Language
Version 2.02
23.Jan.2009

Copyright 2006 Etrol Ltd England

Ok fEsc 1
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